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Executive Summary 

The objective of ASCOS Work Package 2.4 is to design, develop and implement tools in support of continuous 

safety monitoring. This study builds on the results of the following ASCOS Work Packages: 

• WP2.1 Framework safety performance indicators 

• WP2.2 Baseline risk picture for the total aviation system 

• WP2.3 Process for continuous safety monitoring 

 

Based on the analysis of the reports of these ASCOS Work Packages, requirements for an analysis tool are 

developed.  

Development of the tool is accomplished starting with a pilot project to test the approach to SPI development 

and to evaluate the user interface. The development of the tool itself makes use of the experience gained in 

the pilot project.  

Experience in the use of the tool shows it to be quite stable and delivering the requested result. 

This report describes the tool. 

In addition to the ASCOS analysis tool, a tool to generate occurrence test data on a large scale is developed by 

the JRC. Use of generated test data avoids issues related to confidentiality of the reported occurrence data and 

the sensitivity of published results based on such “life” occurrence data. 

The development of the ASCOS tool is complemented by the development of a user manual. 
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 Introduction 1

1.1 Background 

Historically, aviation safety monitoring and safety oversight is performed on basis of a cycle of (multi)-yearly 

audits. It is recognized that there is a need for monitoring on a more frequent basis, i.e. applying a Continuous 

Monitoring Approach (CMA) as solution to collecting and analysing more regular information regarding the 

level of safety. This will allow stakeholders in international civil aviation to base their decisions on the latest 

information available. The CMA principles are based on a system to monitor safety continuously with the 

ability to monitor safety performance at all times. Successful implementation will depend on appropriate 

support tools, procedures and guidance material ensuring synergy between all safety information inputs. 

A proper CMA implementation requires the development of specific safety performance indicators for states, 

airlines, airports, Air Navigation Service Providers as well as for aviation products designed and manufactured. 

Because there is a necessity to handle large amounts of safety data and exposure data, it will be necessary to 

use software tools and databases that are designed according to a commonly used taxonomy, such as used in 

the ICAO Aviation Data Reporting Program (ADREP), the European Central Repository (ECR), and/or the 

European Coordination Centre for Accident and Incident Reporting Systems (ECCAIRS). 

In view of this, in the context of ASCOS WP “Continuous Safety Monitoring”, the Work Package 2.4 is aimed at 

developing “Tools for Continuous Safety Monitoring” (ATCSM). The tools should enable use of safety data 

extracted from an ECCAIRS compatible repository (ECR, ADREP or national occurrence databases) 

complemented with (historical) exposure data as available from existing sources where applicable completed 

with numbers based on expert judgement. Ultimately the tools will provide an overview (in the form of tables, 

charts, visual indicators) of the evolution of the safety performance. These tools can be used to also monitor 

these (and other) safety performance indicators in the future. The ASCOS Tool for Continuous Safety 

Monitoring (ATCSM) should permit the construction of Safety Performance Indicators as described in ASCOS 

WP 2.1 “Framework Safety Performance Indicators” (Appendix A “List of Safety Performance Indicators”). 

Safety Performance Indicators not based on occurrence reporting are not planned to be covered.  

 

It is expected that some of the proposed indicators may not be constructed due to missing matching 

entries in the ECCAIRS taxonomy. Consequently, proposals would then have to be made to the ECCAIRS 

taxonomy working group to enhance the ECCAIRS taxonomy with a view to facilitate its use in the 

context of ASCOS. While, at the time of writing this document these proposals have not yet been 

implemented, it is assumed that they will be implemented in due course and so that occurrences reports 

can be analysed based on the proposed event types.  

For the development, it is assumed that the occurrences would become accessible in an ECCAIRS 5 type data 

base so that standard ECCAIRS 5 software can be used to retrieve and analyse the data. It is also assumed that 

the user of the tool would be familiar with the ECCAIRS taxonomy and its use in aviation occurrence reporting. 
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No assumptions are made in respect to the exposure data other than its availability in a format which can be 

used to provide such data to the ATCSM. The provision/formatting of appropriate exposure data for the 

proposed safety performance indicators will be the responsibility of the user and the development of such 

data is outside the scope of ASCOS WP 2.4 “Tools for continuous safety monitoring”. 

1.2 Objectives 

The main aim is to develop and implement tools in support of continuous safety monitoring. This includes: 

• To develop the requirements for a ‘continuous’ safety performance analysis tool; 

• To test a proposed approach to Safety Performance Indicator (SPI) development; 

• To design, develop, implement and evaluate an user interface for the analysis tool; 

• To develop a tool to generate occurrence test data on a large scale, in order to avoids issues related 

to confidentiality of occurrence data and sensitivity of results based on such “life” occurrence data. 

• To develop a User Manual as guidance for the use of the analysis tool by interested parties. 

• To perform a usability evaluation and assessment, and use recommendations to improve the tool. 

1.3 Approach 

The development of the tool is carried out in five phases.  

In phase 1, the requirements for the tool are analysed based on the SPIs proposed in ASCOS Work Package 2.1. 

The majority of these SPIs are timelines of occurrences rates aimed at showing the development of the 

indicators, the rate of occurrences, over time. It should be noted some of the Indicators proposed by ASCOS 

WP1 may not be constructed based on occurrence data. They include those related to the number of 

meetings, the assessment of infrastructural changes, the number of organisations that have fully implemented 

a Safety management Systems, etc. Such indicators are not taken into account in the context of ASCOS WP2.4. 

In monitoring changes in the aviation system related to the introduction of ASCOS approaches, it would be 

important to be able to compare the effect of ASCOS approaches with parts of the aviation system not 

affected by the ASCOS approach. For example, it could be helpful to be able to compare the safety 

performance of a new aircraft type certified following the ASCOS method with the safety performance of 

similar non-ASCOS certified aircraft types. The capability to develop SPIs for this purpose becomes one of the 

design requirements. 

In ASCOS WP 2.3 “Process for Continuous Safety Monitoring”, it is proposed to monitor SPIs by comparing 

current developments with historical data. The capability to carry out such type of analysis becomes another 

design requirement.  

In phase 2, a pilot project is developed to determine the feasibility of the approach to constructing safety 

indicators and to evaluate how the user interface could be enhanced to simplify the use of the tool. SPI’s 
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proposed in WP 2.1 “Framework for Safety Performance Indicators” are developed and the ease of using the 

tool as well as the quality of the SPI graphs is evaluated. 

In phase 3, a revised tool is developed based on the experience in the use of the tools developed in the pilot 

project. In addition, a user manual is developed. The tool is implemented and tested in the JRC before it being 

handed over to Deep Blue for evaluation of its usability. 

In phase 4, the ASCOS partner “Deep Blue” carries out an evaluation of the usability of the tool. The work is 

described in Chapter 4. Usability issues are identified.  

In addition, the NLR tests the tool and provides recommendations for improvement. 

In phase 5, the JRC reviews the comments and suggestions and identifies those that could be addressed on 

short notice. The tool is revised. The user manual is updated accordingly. The manual is available at request. 

The tool is tested using random generated test data. The JRC develops a tool to facilitate the test data 

generation. The use of random generated test data avoided issues related to access rights to occurrence data, 

privacy concerns, etc. In addition, the testing of the ATCSM is not impacted by occurrence data quality issues.  

Note that SPI graphs shown in this report are developed based on test data and do not reflect reality. 

1.4 Structure of the document 

Following this Introduction, Section 2 describes the environment (legislative, data, and software) for the 

development of the analysis tool. Section 3 describes the ASCOS Tool for Continuous Safety Monitoring 

(ATCSM). Section 4 deals with the generation of (simulated) test data. Section 5 provides the results of the 

usability evaluation and assessment, and includes initial recommendations for improvement of the tool. Most 

of these recommendations are implemented. Conclusions and recommendations are provided in Section 6. 
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 Environment of the tool for continuous monitoring 2

2.1 Legislative environment 

Much legislation is at hand governing the reporting of occurrence data.   On the top, we find the international 

requirements for States to set up mandatory occurrence reporting system as described in Chapter 5 of Annex 

19 – Safety Management - of the International Civil Aviation Organisation ICAO.
1
 In addition to the 

establishment of mandatory occurrence reporting systems, the Annex compels States to also establish a 

voluntary incident reporting system “to facilitate collection of information on actual and potential deficiencies 

that may not be captured by the mandatory incident reporting system”.
2
 

At European level, the ICAO requirements for the establishment of mandatory occurrence reporting systems at 

the level of states were transcribed into Directive  of the European Parliament and of the Council 2003/42/EC

of 13 June 2003 on occurrence reporting in civil aviation. This Directive has been complemented by two 

regulations - Commission Regulation (EC) No 1321/2007 of 12 November 2007 laying down implementing rules 

for the integration into a central repository of information on civil aviation occurrences exchanged in 

accordance with Directive 2003/42/EC of the European Parliament and of the Council – and Commission 

Regulation (EC) No 1330/2007 of 24 September 2007 laying down implementing rules for the dissemination to 

interested parties of information on civil aviation occurrences referred to in Article 7(2) of Directive 

2003/42/EC of the European Parliament and of the Council. In addition, REGULATION (EU) No 996/2010 OF 

THE EUROPEAN PARLIAMENT AND OF THE COUNCIL of 20 October 2010 on the investigation and prevention of 

accidents and incidents in civil aviation, provided additional clarification on access to data in the European 

Common Repository of occurrence reports.  In April 2014, Regulation (EU) No 376/2014 of the European 

Parliament and of the Council of 3 April 2014 on the reporting, analysis and follow-up of occurrences in civil 

aviation has been published. When it comes into effect in 2015, it will supersede Directive 42/2003 and the 

two related regulations. Through it, existing requirements have been strengthened and it is expected that its 

application will lead to a more harmonized manner in which occurrences will be reported in the EU. 

Mandatory occurrence reporting within the industry, e.g. from an operator to a manufacturer etc., is governed 

by  REGULATION (EC) No 216/2008 OF THE EUROPEAN PARLIAMENT AND OF THE COUNCIL of 20 February 

2008 on common rules in the field of civil aviation and establishing a European Aviation Safety Agency and 

related guidance material in AMC 20-8.
3
 

In summary, there exists a comprehensive legislative framework in the EU in which occurrences are to be 

collected, analysed and stored. Based on this framework, the occurrences required to permit the construction 

of the Safety Performance Indicators are available in principle. 

                                                                 
1
 ICAO Annex 19, Chapter 5, Standard 5.1.1 

2
 ICAO Annex 19, Chapter 5, Standard 5.1.2 

3
 General Acceptable Means of Compliance for Airworthiness of Products, Parts and Appliances 

AMC-20 as contained in EASA ED Decision 2003/12/RM as amended. 
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2.2 Data environment 

Based on the abovementioned legislation, a Common European Repository of occurrences had been 

established which, by July 2014, contained more than 840 000 reports.  All States of the EU plus the associated 

States – Iceland, Norway and Switzerland report their occurrences regularly.  

While thus the mechanism for reporting has been established, issues remain in respect to the quality of the 

0ccurrence data.  Review has shown that much of the information essential for analysis is missing. Efforts are 

under way to improve the quality of the data – notably through aspects of regulation 376/2014
4
 which have 

made it mandatory to provide essential data.  Other efforts aim at providing guidance to States on how to 

complete the reports, providing feedback related to the completeness of reporting, the development of 

guidance material, improved user interfaces and developing and deploying data quality verification tools
5
.    

The proposed SPI’s are rates or ratios based on the frequency of the observed events in the occurrence data 

pro-rated by the use, the exposure, of the product or part of the aviation system in question. For the use of the 

ATCSM, usage data of the aviation systems is thus equally important as the occurrence data. 

There is no equivalent common European storage for the usage / exposure data as there is for the occurrence 

reports nor is there a related legislative requirement to establish one.  Some usage / exposure data is collected 

at the level of States, reported to EUROSTAT and made available for use.  By June 2014, tests have shown that 

while EUROSTAT appears to provide the infrastructure to disseminate data e.g. on the usage of aircraft, no 

actual data could be found for recent years. 

In respect to the data provided by EUROSTAT, it is noted that there is some time lag until data has been 

provided in full by all States.  This time lag negates the use of this set of data when trying to monitor on-going 

activities.   

EUROCONTROL collects data on aircraft movements and makes it available based on the analysis of the flight 

plans filed and the flights executed.  In respect to EUROCONTROL, the exposure data is complete for the scope 

of aviation covered, it is correct and timely. However, EUROCONTROL does not cover most of the general 

aviation activities – there is no data for flights for which no flight plan was filed. The user of the data must be 

aware that the EUROCONTROL exposure data covers all IFR flights and only those VFR (Visual Flight Rules) 

flights which are chargeable. This condition should also be applied to the occurrence data when calculating 

rates using EUROCONTROL data. Note that the data are not limited to European operators only and covers all 

flight crossing or entering the states covered by STATFOR. 

 

                                                                 
4
 Regulation (EU) No 376/2014 of the European Parliament and of the Council of 3 April 2014 on the reporting, analysis and 

follow-up of occurrences in civil aviation. 
5
 Data Quality Rules for ECCAIRS 5: Occurrence Categories update 4 March 2013, available on the ECCAIRS portal – Support 

– Usage examples 



 

     

    

Ref: ASCOS_WP2_JRC_D2.4 Page: 18 

Issue: 1.1 Classification: Restricted 

    

 

ASCOS — Aviation Safety and Certification of new Operations and Systems Grant Agreement No. 314299

 

 

Access to the EUROCONTROL data via their interactive dashboard proved to be cumbersome and some desired 

data on traffic by aircraft type could not be extracted.  

Other usage data is collected within the industry. It covers, among other aspects, information on the usage of 

individual aircraft. However, not all stakeholder report their data and estimates are used to complete the 

picture. While such data is in principle very useful to develop occurrence rates for specific aircraft types, it is 

costly and, because of the reporting issues mentioned above, incomplete.  

Irrespective of the data sources used, monitoring the impact of ASCOS on occurrence rates will be a challenge 

as presently neither occurrence nor exposure data is identified as being related to an ASCOS activity. 

2.3 Software environment 

The ECCAIRS system has been developed to facilitate the reporting of occurrence data in a common format by 

Member States to a central European data base, the European Central Repository (ECR).  The development of 

the ECCAIRS system goes back to the 1990
th

. The present system version is ECCAIRS 5. ECCAIRS comprises of a 

set of tools to collect, store, integrate, disseminate, verify and analyse occurrence data.  

In addition to tools related to the handling of the occurrence data, tools have been developed to maintain the 

ECCAIRS taxonomy, the ECCAIRS user interface, develop data quality rules, websites etc. In summary, the 

ECCAIRS system comprises today of a large number of tools specifically developed to facilitate the 

maintenance of the European Commission’s occurrence reporting scheme. 

In respect to analysis, ECCAIRS had offered since 2005 a tool to extract information from ECCAIRS data bases 

for use in Excel spreadsheets.  This tool, called the Aggregate Workbench (AWB), is widely used in the 

community
67

. However, the use of the AWB requires some experience in the handling of Excel as well as 

knowledge of structure of the ECCAIRS taxonomy.  Certain aspects in the reported occurrence data - e.g. the 

varying use of either local dates or UTC dates or both – complicate the analysis when using AWB. Consequently 

only those organisations, where related expertise is at hand, can make good use of it.  The European Aviation 

Safety Agency (EASA) provides related training.
8
 With the ASCOS tool specifically aimed at developing time 

series of occurrence rates, the AWB with its wider scope and different focus will remain a major tool for the 

analysis of ECCAIRS data. 

 

                                                                 
6
 See: 2005 ECCAIRS Steering Committee, presentation of the JRC on the AWB Add-In, access via: 

http://eccairsportal.jrc.ec.europa.eu/index.php/hidden-FMS/204/0/?&rootname=scm2005-2presentations 

 2006 ECCAIRS Steering Committee, presentation by EASA on the use of the AWB, access via : 

 http://eccairsportal.jrc.ec.europa.eu/index.php/hidden-FMS/204/0/?&rootname=scm2006presentations

2009 ECCAIRS Steering Committee, Workshop on AWB and Dexter, access via: 

http://eccairsportal.jrc.ec.europa.eu/index.php/hidden-FMS/204/0/?&rootname=scm2009presentations 
7
 See presentation on the use of the AWB for national statistics in Norway: 

http://www.luftfartstilsynet.no/incoming/article9515.ece/BINARY/Workshop+3+Rapportering+av+hendelser.pdf 
8
 http://easa.europa.eu/system/files/dfu/TT%20Catalogue_2014_v2%20(July%202014).pdf 
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 ASCOS Tool for Continuous Safety Monitoring (ATCSM) 3

3.1 Description 

3.1.1 General 

The ATCSM is a program which interacts with an ECCAIRS 5 occurrence data base and user provided exposure 

data to develop rates of occurrences, the Safety Performance Indicators (SPI). The SPI is presented in graphical 

form to the user.  

The tool is equipped with menus that facilitate the development and maintenance of libraries of Safety 

Performance Indicators. Within a given library, the SPIs can be grouped in categories. One level of 

categorisation is available. 

Each SPI in the library represents the combination the results of a query to an ECCAIRS 5 data base and 

matching exposure data.  Exposure data are assigned individually to the SPI’s during development.  

The exposure data itself is loaded into the tool by the user at the time of configuring the SPI library. 

The ATCSM has been developed to permit the development of SPIs in the form of timelines of occurrence 

rates, to have the capability to visually compare results from two data sets in respect to certain issues as well 

as the capability to allow a user to visually compare historic occurrence rates with current occurrence rates. 

3.1.2 Simple timeline SPI 

In respect to the development of “simple” timelines, the user needs to define the appropriate query to 

retrieve the occurrence data from the ECCAIRS data base and assign related exposure data. 

Example: 

 

Figure 1- Example of an SPI based on a single timeline 
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3.1.3 Set comparison SPI – concurrent display of two sets of rates 

At the level of the SPI library the user can define two “filters” to identify the two sets of occurrence rates to be 

displayed in the same SPI graph.  One is referred to as the “Base” filter and one as the “Benchmark” filter.  For 

example, the user could define the “Base” filter to select all occurrences in which there was a “correct” crew 

reaction to a GPWS warning and as the second set using the “Benchmark” filter for those occurrences in which 

an incorrect crew reaction had been recorded. 
9
 Figure 2 shows the two sets merged into one graph, figure 3 

shows the two sets in separate graphs. The graphs are based on test data, they are not based on real 

reporting. 

The tool provides a visual indication of the development of rates. However, comparing rates without a proper 

statistical analysis is not recommended. First confidence intervals have to be determined for each rate to see if 

the sample size is large enough to calculate accurate rates. Second formal statistical tests should be used to 

determine if differences in the rates are significant.  Trend lines, while looking nice and convincing, may be of 

questionable statistical validity and should not be used without further in-depth statistical review. 

 

Figure 2 Example of an SPI showing development of two data sets in a merged graph 

                                                                 
9
 Results shown are based on occurrence data generated by the JRC to test the ATCSM  
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Figure 3 Example of an SPI showing development of two data sets in separated graphs 
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3.1.4 Historic evaluation SPI 

The tool has been developed with a view to permit the evaluation of current data in relation to historic data. 

The requirement for such type of analysis was outlined in ASCOS Final Report on work Package WP 2.3 which 

shows on page 27 one way how an alert level could be defined: 

 

Figure 4 - Image of figure 2 from report of ASCOS WP 2.3 

 

Based on this example, the ATCSM was designed to “split” the graph pane into two areas: the left, called 

“initial” area and the right called “evaluation” area. The dividing line between the two areas can be moved by 

the user to the left and right as required. 

The evaluation area is indicated with a grey background, while the background of the initial area in the SPI 

graph is white.  

The calculations related to the average, standard deviation and trend are based on the visible initial data in the 

“white area” only, but the lines for averages trends etc., if selected to be shown by the user, are 

“extrapolated” from the “initial” into the evaluation area. Data points which fall below the average minus one 

standard deviation in the evaluation area are coloured in green, data points exceeding the average plus one 

standard deviation are coloured in red. 
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Below is an example showing a hypothetical number of occurrences with numbers in some month of the 

evaluation period exceeding the average plus standard deviation in red and one month with the number falling 

below average minus one standard deviation in green. 

:  

Figure 5 - SPI graph showing initial and evaluation area 
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3.2 SPI visualisation 

3.2.1 The SPI project window
10

 

 

Figure 6 SPI project window 

The PROJECT window (above) is divided into three main areas: 

a) The Menu ribbon: Display of the selected main menu (above “PROJECT”) 

b) The SPI tree with the hierarchy of  

a. SPI project name 

b. SPI category 

c. SPI individual name 

c) The SPI graph pane which may be  

a. Empty (no category, no SPI selected) (as above) 

b. Showing a summary of all SPI graphs of the selected category 

                                                                 
10

 The menu structure has been revised in Phase 5 of the project. The revised approach is described in the user manual. 

This report refers to the original version developed in phase 3. 
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Figure 7 SPI summary graph image 

c. Showing the SPI graph of the selected SPI 

 

 

Figure 8 Individual SPI graph image 
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The SPI graph is made up of a header section (in grey) on top of the SPI graph and the SPI graph image 

showing the SPI graph. 

 

SPI header: 

 

Figure 9 SPI header 

The SPI header provides information on: 

- the SPI name – free text; 

- the SPI Description – free text; 

- the name of the exposure data set used in the calculation (for the “base” and for the “benchmark”) 

data set; 

- the name of the user, the name of the occurrence data base used to calculate the SPI and the time 

the SPI was calculated; 

- the criteria used to extract data from the ECCAIRS occurrence data base (by pressing on the , the 

criteria are displayed in on the SPI graph pane, for example

 

Figure 10 SPI criteria display window 

 

SPI graph pane 

The SPI graph pane can be subdivided by the user into an “initial” period and an “evaluation” period.  The 

“initial” period is identified via a white background and the evaluation period is shown with the grey 

background.  

In the area of the evaluation period, data points for which the value is below the average – 1 standard 

deviation are coloured in green while those data points for which the value is above the average + 1 standard 

deviation are coloured in red. 
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A legend may be displayed below the SPI graph title.  

The lines for average, trend etc. are shown as solid lines in the initial period but are shown as broken lines in 

the evaluation period to indicate that they are not influenced by the data belonging to the evaluation period.

 

Figure 11 SPI with legend, averages and trend lines 

 

3.3 Management of the ATCSM 

The ATCSM is managed through a set of menus.
11

 They are: 

- FILE  a menu to manage ATCSM project files and data base connections; 

- PROJECT  a menu to set global parameters for the project; 

- SPIs   a menu to manage individual SPIs. 

 

3.3.1 The “FILE” menu 

SPI projects are stored as “*.esl” files.  They are managed though the “File” sub-menu of the “FILE” menu. 

                                                                 
11

 The menu structure has been revised in Phase 5 of the project. The revised approach is described in the user manual. 

This report refers to the original version developed in phase 3. 
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.  

Figure 12 File menu 

Before any SPI can be calculated, the tool needs to be connected to an ECCAIRS 5 type data base.  To 

accomplish this, the ECCAIRS login dialogue is triggered when the tool is started: 

 

Figure 13 ECCAIRS login window 

While in principle the user would need to complete the various options shown above (repository, language, …), 

in practice, as seen here, only the password needs to be entered when the other settings have already been 

set during a previous session and are retained by the system. 

Should there be a need to disconnect from the data base in use and to connect to another occurrence data 

base, the user clicks on the “Connect” icon shown in the “repository” sub menu of the FILE menu of the tool. 

This triggers the login dialogue.  This sub menu is found to the right of the “File” sub menu of the “FILE” menu. 

3.3.2 The “PROJECT” menu 

The “PROJECT” menu serves to manage general properties of the project.  

 

Figure 14 Project menu 
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They include: 

- The base filter – defining the “main” data set to be used in the SPI’s; 

- The benchmark filter – defining the second data set to be used for the SPI’s; 

- Import and export of exposure data; 

- Management of SPI categories; 

- Import and export of queries from/to an ECCAIRS query library.   

The ATCSM is designed to provide the user with the capability to compare two data series with each other. For 

example, the first data series could be the made up of the occurrences reported by one State, while the 

second one would be made up by occurrences from all other States in Europe. The user would thus be in a 

position to “compare” the two data sets based on various other criteria.  

The “base filter” is a logical expression developed via the ECCAIRS query builder that defines the first data set. 

The “Benchmark filter” serves a similar purpose, but defines the second data set of the SPI project, the one 

that the first data set is to be compared with. 

The ECCAIRS query builder dialogue is started by pressing the “Base filter” / “Benchmark filter” in the “Filter” 

sub-menu of the “PROJECT” menu.  The dialogue window appears as follows: 

 

Figure 15 Base filter definition window 

Pressing the  in the top right corner open the query builder window of the ECCAIRS system. 

 

Figure 16 ECCAIRS query builder window 
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For details of the development of queries, see the E5-ECF-User Manual and the White Paper – ECCAIRS 5 

Advanced Querying available on the ECCAIRS portal.
12

 

Import / Export of exposure data 

Exposure data is uploaded to the ATCSM via the “Exposure data” sub menu of the “PROJECT” menu.  By 

pressing the “Import/Export/Remove” the exposure data management window is opened: 

 

Figure 17 Exposure data management window 

Buttons on the bottom permit the import/export/removal of exposure data.  Note: the name of the exposure 

data, appearing in the “name” sub-window, as well as the description are provided as part of the exposure 

data xml structure as seen in the example below: 

 

Figure 18 Example of an exposure data structure 

                                                                 
12

 eccairsportal.jrc.ec.europa.eu 
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Note: the data does not have to be in order. Data series containing duplicate entries will be rejected.  When 

saving the SPI library, the exposure data is included in the resulting “*.esl” file. 

Category management 

Categories can be added (Option “new”), edited (Option ”Edit”) or deleted (Option ”Remove”) via the 

“Category” sub menu of the PROJECT menu. Note that the options “Edit” and “Remove” are only activated 

once a category has been selected (Selection of a category is indicated by the box around the category name 

as seen below). 

 

Note: by right clicking on a category name, these edit options are also available. In addition, SPI’s in the 

selected category can be recalculated. Note: Categories cannot be copied to the clipboard. 

 

Figure 19 Category management window 

Note: right clicking on an SPI provides similar options, but also includes the option to copy the SPI for pasting.  

benchmark graph 

Figure 20 SPI management window 
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Import / Export of queries 

Note:  SPIs, by design, combine query results with exposure data. ECCAIRS queries stored in ECCAIRS query 

libraries do not contain any reference to exposure data. Consequently, queries imported from an ECCAIRS 

query library will be flagged as incorrect as exposure data is missing. Similarly, SPIs exported to query libraries 

and re-imported will be flagged as well since the reference to the exposure data is not exported.  

Nevertheless, the importation of queries may be quite useful since the use of existing queries reduces the time 

required to develop SPIs. 

Import/Export is controlled via the Import/Export sub menu of the PROJECT menu: 

 

Figure 21 Import/Export sub menu 

Import of queries 

Pressing the “Import queries” icon in the “Import/Export” sub menu of the “PROJECT” menu will trigger the 

following message to be displayed” 

 

Figure 22  Query import warning window 

The intent is to warn the user that the import of queries from the query library will overwrite the existing SPI 

library. 
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If the user responds with “OK” a standard file management window will be opened in which the available 

query libraries (“*.eql*” files) are displayed.  After the import has been completed, the ATCSM displays the SPI 

tree as seen here: 

 

Figure 23 SPI tree after query importation 

Note: All SPIs are shown in red as after importation since none of the SPIs has any exposure data assigned.  

The user needs to assign exposure data for each individual SPI. 

Export of SPIs as ECCAIRS queries 

Pressing “Export” opens a standard file dialogue in which the user can determine the name and the location of 

the query library in which the queries of the SPI’s of the project will be stored.  

3.3.3 The “SPIs” menu 

 

Figure 24 SPIs menu 

The SPIs menu is used to manage the parameters controlling the appearance of SPIs as well as recalculation 

and exporting of SPIs. 

Note:  Some of the SPI parameters are global – i.e. they apply to all SPI’s in the library, others are SPI specific 

(local), i.e. they have to be set by the user for each SPI in the library and only apply to the specific SPI. 

- SPI global parameters are managed through the sub-menus of the “SPIs” menu. They include 

o Graph style (bar or line graph); 

o Graph types (single series or two-series display); 
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o Timeline - level of detail (by year, year and quarter and year and month); 

o Additional SPI graph info (lines that are added to the SPI graph. They are turned on/off via 

the Show/Hide submenu); 

o Display of the legend. 

 

With the exception of the date range applied to SPI graphs and legend display, the global parameter 

can be managed in the “Default” window. The “Default” window is activated when pressing the 

“Show default” in the “Options” sub menu of the SPIs menu. 

 

 

Figure 25 SPI default setting window 

Note: the “Series options” parameters (free text) are used to provide the legend text for the “main” 

and “Benchmark” series.  

 

 

- SPI local parameters 

o SPI title; 

o Benchmark title; 

o SPI Y-axis limitation; 

o SPI scaling; 

o SPI query; 

o SPI exposure data assignments. 
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SPI local parameters are managed through the SPI edit window that is activated via the “Edit” option 

in the “Manage SPI” sub menu of the SPIs menu or via right clicking on the SPI name in the SPI tree. 

 

 

 

The SPI edit window: 

 

 

Figure 26 SPI edit window 

 

SPI edit window parameters: 

o SPI name – Plain text; 

o Description – Plain text; 

o Definition – displays the criteria used to extract data from the occurrence data Base. Editing 

of the criteria (pressing on the  to the right of the definitions) opens the ECCAIRS query 

builder dialogue window: 
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Figure 27 Example of a query 

o Graph Title - the title to be displayed in the SPI graph; 

o Exposure data – the name of the exposure data set to be used for the calculation of the rate 

of the “main” series;

 

o Pressing the  shows the list of all available exposure data sets; 

o Do not use base filter - Option to select that the base filter is not to be used.  This option 

may be helpful, if SPIs not related to the main filter are to be shown; 

o Benchmark Graph title - the title of the “Benchmark graph”. The title line that is used in the 

second graph of the “benchmark and main graph separated” graph type; 

o Benchmark exposure data - the name of the exposure data set to be used for the calculation 

of the rate of the “Benchmark” series; 

o Scaling - the factor with which the resulting rates are to be multiplied to obtain values in a 

desired range, e.g. certain accident rates may be shown as “in a million” flights, other rates 

may be shown as “in a 1000 movements”; 

o Maximum Y scale - pre-set to 1 – the maximum value applied to the Y-axis.  If any value of 

the series to be displayed exceeds the maximum value listed here, the maximum value of the 

series is used for the Y axis scaling.  This feature is helpful in cases SPIs need to be compared 

in which the maximum value of the series differs so much that the automatic scaling of the Y-

axis differs and thus makes a visual comparison difficult. 

 

- SPI exports: Exports are managed through the “Export” submenu of the “SPIs” menu: 
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The exporting exports the data of the SPI selected in the requested format:  

 

- PDF:  the image of the SPI graph is exported to a “*.PDF” file. 

 

Figure 28 PDF image of an exported SPI 

 

- Excel: the data of the SPI and the SPI graph are exported. Note that the SPI graph in Excel is 

drawn using Excel standard tools and its image differs from the developed by the ATCSM.  The 

resulting Excel file is a workbook with three worksheets: 

 

Figure 29 Export into Excel - workbook structure 

 

The worksheet SPI data contains the data for the SPI: 

 

Figure 30 Export into Excel - SPI data 
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The worksheet “SPI” contains the SPI graph. 

 

Figure 31 Export into Excel - SPI graph 

 

Word: The image of the SPI graph in exported to the Word file. 

 

- SPI recalculation 

There are three options to recalculate SPIs: selected SPI, all in the selected category and all SPI’s of 

the project.  Re-calculation is triggered by pressing the related icon in the “Recalculate” sub menu of 

the “SPIs” menu.  

 

Figure 32 Recalculate sub menu 

Note: recalculation of all SPIs in the current category can also be triggered via the category edit pop-

up window, recalculation of a specific can be triggered via the SPI edit pop-up window. 

Note: Recalculation involves re-querying the data base. Recalculation does not “refresh” the exposure 

data.  Updating exposure data can only be accomplished via the exposure data management sub 

menu of the PROJECT menu.  
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 ATCSM Test Data generation 4

4.1 Background 

Part of the work to be accomplished in ASCOS WP 2.4 was an assessment of the usability and “fit-for-purpose-

ness” of the developed safety monitoring tools. In this context, it was planned to use the tool to carry out 

several hypothetical studies by non-trained staff and evaluate the usability of the tool. 

In preparation for these test studies the need for the provision of appropriate test data was noted. Considering 

the sensitivity with which the aviation community treats reported incident data, it was considered that for 

testing purposes no real data could be used. Randomly generated occurrence reports were to be used instead. 

Nevertheless, the occurrence data generated should reflect in some way reality so as to ensure that results of 

the “analysis” would not be rejected by the user community as completely unrealistic. Given that underlying 

data was generated and was not based on real reporting, no restrictions exist in respect to the publication of 

related test results as long as it is made clear to readers and audiences that all data were results of random 

generations and that any trends depicted in the data were either the effects of statistical noise or were 

intentionally included when the data was generated. 

The use of artificially generated data has the additional advantage that problems frequently noted in “real” 

data, which include the incomplete reporting of relevant background information, the presence of 

contradictory data etc. will be avoided.  Consequently, the evaluation of the tool will not be impeded by errors 

in the data. 

The test data only contain values of attributes considered relevant to for a given test exercise.  No other data 

were included. Test data can therefore only be used for the purposes generated.  

A sufficient number of test reports were to be generated, thus, manual development of test data was ruled 

out and appropriate automated methods had to be developed. 

Some ad-hoc studies were carried out to determine what distribution of the data could be considered 

reasonable. Results of these studies were used as a base for desired distribution of test data. 

Rate calculation can only be carried out based on exposure or movement data. For the test purposes simulated 

movement data for Europe (EU28) was used. For the occurrences six airports selected as examples for one 

scenario, the number of movements for each group was simulated.   
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4.2 Scenarios 

Four scenarios for testing the usability of the tool have been proposed as follows: 

4.2.1 Scenario 1 – Runway incursions 

The scenario calls for an analyst to evaluate the impact of Runway Incursion and Collision Avoidance System 

(RIMCAS) at an airport. In preparation, a study is to be performed to evaluate the impact such a system may 

have.  It was assumed that the system had been introduced at Frankfurt, Geneva and Milano-Malpensa and 

that Amsterdam, Brussels and Paris (CDG) were assumed not to have such a system. The goal was to 

determine whether such a system would make a difference. 

Two sets of aerodromes were to be compared. The goal was to show that differences between the two sets 

would be visible based on the different severity distributions which were used for the random generation of 

the severity of the reports for each of the two groups. 

In summary: 

- Set of 2473 generated reports covering the time period with 1100 reports for one set of aerodromes 

and 1373 for the second set. This distribution is aimed to be similar to the levels of activity at the two 

groups of aerodromes; 

- Severity of the occurrence 

o Based on assumed distribution but with differences in the severity between the two groups; 

- Risk grade and occurrence category based on the severity of the occurrence; 

- Random dates covering the full test period; 

- Encounter geometry – random; 

- Evasive action – random; 

- Severity classification – random; 

- Random selection of vehicles involved but aligned with assumed distribution; 

- No aircraft details generated. 

Exposure data – simulated number of departures by month, aggregated by quarter and by year. 

The results reflect the assumption underlying the data generation that on average the rate of high risk 

incursions at the group of aerodromes supposedly equipped with the RIMCAS system is lower than in the 

comparable set, even though the rate of incursions total does not differ significantly. 

Interestingly, however, while the trend of the rate of all incursions is flat (as expected), the trend of the rate of 

high risk incursions varies from one test sample to another due to the effect the random distribution of the 

low number of test reports bearing a high risk.   
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4.2.2 Scenario 2 – monitoring occurrences related to auto-flight systems 

This scenario calls for a study of auto-flight system failures with a comparison of the last 5 years with the 

preceding 5 years. 

For the purposes of this scenario, one set of data covering the proposed period of 10 years was developed.  

The reports were generated so that the results should show that no statistically significant change can be 

observed for the set of data as a whole, apart from some variations resulting from the random generation of 

the test data set. 

In summary: 

- 2000 reports generated; 

- Distribution by year simulated to be in line with assumed yearly distribution of departures in Europe; 

- Distribution by month simulated to be in line with assumed monthly departures in Europe; 

- Distribution by day – fully random; 

- Distribution by states  - random; 

- Distribution by aircraft type - random with assumed aircraft distribution; 

o But excluding helicopters and light aircraft (below 2250 kg MTOM);  

- Event phase aligned with general phase (Attribute 391); 

- Distribution of event phase of operation random but aligned with values found in Attribute 121 

(general phase) of the ECCAIRS taxonomy (Version 2.4.0.0)); 

- Severity based on assumed severity; 

- Damage level (aircraft) aligned with severity; 

- Damage level (occurrence) aligned with damage level aircraft; 

- Risk grade – aligned with occurrence class. 

Results show that, as designed, on average no change in the rate of such occurrences can be observed. 

 

4.2.3 Scenario 3 – monitoring of the reaction of the crew to EGPWS warnings. 

A study was to be carried out to determine the effectiveness of training practices in relation to the crew 

reaction to GPWS warnings.   

One data set covering the proposed period of time was developed with the intent to show that, over time, the 

probability of a correct crew reaction was increasing. To accomplish this, the probability of a correct crew 

response on a given day was derived using a linear interpolation of the probability from a given lower value 

assumed at the beginning of the period to a higher at the end of the period.  

In summary: 

- 2000 reports generated. 

- “Crew reaction” randomly generated with an increasing probability of generating “correct” actions 

and a corresponding decreasing probability of generating “incorrect” actions; 

- The date of occurrence - generated at random but with a distribution based on an assumed yearly as 

well as monthly distribution of departures in Europe; 
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- State of occurrence –  random – based on assumed distribution; 

- General phase of flight – random – based on assumed distribution;  

- Specific phase of flight randomly generated and adjusted to the generated general phase of flight; 

- GWPS warning type set to “Terrain” for all occurrences; 

- No aircraft model generated (left empty) as this was not considered relevant for the purposes of this 

study; 

- “Time to react” in seconds randomly distributed between 30 and 230 seconds;   

- State of occurrence distributed at random; 

- Risk grade: randomly generated, but with a reduction of 1 if the crew action generated was 

“immediate”, i.e. in case the random generated risk level was “high” and the randomly generated 

crew reaction was “immediate”, the risk level was reduced from “high” to “medium” and from 

“medium” to “low” correspondingly. 

Results show that, as intended, the rate of correct crew behaviour is increasing over time with a corresponding 

decrease of the rate of incorrect crew behaviour.   

 

4.2.4 Scenario 4: Investigating the safety impact of TCAS II version 7.1 

One set of data was developed covering the two year period from 1 January 2012 to 31 December 2013. It was 

assumed that there was an impact of the introduction of the version 7.1. The impact was simulated through 

the adjustment of the randomly generated severity level of each record. Based on the corrected severity 

levels, the related classifications of the occurrence as “incident” or “serious incident” were derived as well as 

related event types as they are also indicative of the severity of the occurrence. The aircraft type was 

generated based on an assumed distribution of aircraft. Aircraft characteristics – the mass group, the type of 

propulsion etc. were added to the test data at a later stage using an aircraft characteristics reference data 

base. 

In summary: 

 

- 2000 reports generated; 

- Risk level: random number between 0 and 99, modified by a correction factor based on the date of 

the occurrence and a user defined target level; 

- Aircraft make model: random generated based on an assumed distribution; 

- Occurrence class: derived from generated risk level; 

- General flight phase: randomly generated; 

- Event phase: randomly generated based on observed distribution – but aligned with the general flight 

phase (ECCAIRS attribute 121); 

- Event type: derived from risk level; 

- State of occurrence: random generated  but based on assumed distribution; 

- Date: at random over the period but with a distribution by month to reflect assumed monthly activity 

in Europe; 

- Aircraft characteristics were added to the occurrence reports based on data found in an aircraft 

characteristics reference data base. 
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4.2.5 Implementation of test data generation  

The basic data to be generated was stored in an Excel worksheet.  From this worksheet, the data was 

reformatted into worksheets formatted to be suitable input to the ECCAIRS TREX
13

 tool.  TREX is a tool that 

permits the creation of ECCAIRS 5 files based on information contained in an Excel workbook.   

 

In addition to the random generated data, several code values were inserted for “static” values. By “static” we 

mean these values did not change from one test record to another.  “Static” attributes include the code for the 

organisation reporting, the occurrence status etc.  They are required to obtain a formally correct ECCAIRS5 

occurrence record. 

 

The T-REX tool was developed specifically to simplify the creation of occurrence reports in ECCAIRS 5 format.  

It takes as input worksheets in an Excel workbook that mirror the entity structure and attribute values of an 

ECCAIRS occurrence record to generate ECCAIRS5 records.  Only with this tool was it possible to create a 

sufficient number of test records, review them and adapt the generated distribution of the generated values 

to achieve desired results. 

 

While this approach was used extensively for the testing of the ATCSM, the approach to generate test data 

based on assumed distributions could be used wherever the use of “real” data in testing occurrence reporting 

related software is deemed undesirable due to confidentiality issues or when an insufficient number of “real” 

data is available for testing.  

 

The E5F files created by T-REX were uploaded into a data base for analysis.   Results show that, within the 

expected random fluctuations resulting from the use of randomly generated data, the target distributions of 

the values were achieved.  

  

                                                                 
13

 T-REX  - Tool for Rolling your own ECCAIRS data using Excel 
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 Usability evaluation and assessment 5

5.1 Objective 

This section reports on the results of a heuristic evaluation aimed at discovering the usability criticalities of the 

current version of the ASCOS Tool for Continuous Safety Monitoring (ATCSM).  

Usability refers to the extent to which a software product can be used by a specific user to achieve specified 

goals. It pertains the “perceptual and physical characteristics of the human-system interface, and includes 

general issues regarding the ability of users to read, detect, access, and manipulate information.” (Harwood, 

1993, p.6). The consideration of usability issues is important to ensure that the users can find what they are 

looking for quickly and easily, navigate around the product easily, know where they are within the overall 

structure of the software program, and know the options that are available to them (Tullis & Albert, 2008). 

Ultimately, the proper handling of usability issues during the development of new software system has the 

potential to maximize end user acceptability and opportunities for adoption. 

It has to be noted that the present evaluation focuses solely on usability aspects.  Considerations of fitness for 

purpose (or domain suitability)—which pertain the degree to which an interactive system allows a user to 

meet the cognitive demand of the domain—are not addressed in this study. This choice is due to the fact that 

the evaluation of the fitness for purpose falls under the scope of ASCOS validation exercises planned in the 

context of ASCOS Work Package 5. These exercises are currently expected to take place during the period 

November 2014-January 2015. 

 

5.2 Methodology 

The ATCSM has been evaluated using the heuristic or expert evaluation method (Nielsen, 1994). This is a 

consolidated usability inspection method that involves a team of usability specialists to judge whether the 

features of the user interface under analysis follow basic established usability principles or heuristics. These 

are general standards that reflect common properties of usable human machine systems. Experimental 

research has shown that they apply across a wide range of human machine systems. In a typical heuristic 

evaluation, first the evaluators inspect the interface alone going through it several times to explore how the 

system performs compared with the heuristics. In the second phase, the evaluators work jointly to compare, 

refine and aggregate their usability findings.  

The heuristic evaluation presented here assumes as potential users of the ATCSM safety practitioners (i) 

working in the Aviation and/or Air Traffic Management domain(s) for either a manufacturer or a civil aviation 

authority, and (ii) active in the context of certification of aeronautical products and/or services. This profile is 

reasonable considering that it is consistent with the target user of the ASCOS main outcome, i.e. the approach 

to certification of aeronautical products and services, as described by the Work Package 1. 
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As a user task, the evaluation has considered mostly the definition/retrieval of an occurrence data set. This is 

because the definition of the exposure data falls outside of the scope of the system under analysis. In a real-

life situation, the latter need to be collected using methods and software systems external to the ATCSM. The 

evaluation has been conducted using a SAMSUNG standard lap top computer. Computer screen size was 

13inch. 

5.3 Usability Findings 

The present heuristic evaluation has identified nine usability criticalities and a corresponding set of 10 high 

level usability recommendations, as also shown in Table 1.  Each usability issue is covered in detail on a 

dedicated section in the remaining of section 4. It is anticipated that issues from #1 to #8 cover relatively small 

scope usability issues, which call for incremental improvements of the present version of the ATCSM. Issue #9 

addresses a more fundamental (and complex) usability concern that calls for a more substantial improvement.  

Table 1. Summary of the usability issues identified in the context of this study 

# Identified Usability Issues  

(page number is indicated in brackets) 

Recommendation(s) 

1 SPI sub menus disappearing from user view 

when shrinking the ATCSM Project Window (p. 

46) 

1. Ensure that a symbol specific for the SPI submenus 

remains visible when ATCSM Project view is shrunk 

2 SPI recalculation options not immediately 

visible to the user (p. 48) 

2. Place the recalculate option in the context of the 

SPI window. 

3 Lack of clarity between the “File” submenu, 

the “Project Menu” and the entities they relate 

to (p. 49) 

3.1 Replace the name of the “File” submenu with 

“Library”. 

3.2 Consider moving the current four submenus 

contained under the “Project” menu under the File 

(Library) menu. 

4 Opening a library requires the user to open the 

ATCSM first (p. 50) 

4. Consider giving the option to the user to launch 

the ATCSM directly by double clicking on the library 

file icon available on the desktop. 

5 The name of the application displayed in the 

Windows “start” menu differs from the 

application name appearing on the top of the 

ATCMS Project window (p. 51) 

5. Use the same software name consistently across 

different menus and bars. 

6 Library name appearing on the top bar of the 

main software window not clearly readable 

(p. 51) 

6. Replace file path information on the top bar of the 

ATCSM with the name of the currently open library. 

7 Repetitive selection of the query text line 

required in the SPI query builder (p. 52) 

7. When opening the SPI Query builder, the selection 

bar should appear automatically over the first row of 

the active window in which a text line appears. 

8 Ambiguous symbology used for the editing 

function (p. 53) 

8. For the editing function, use a symbol different 

from the play (“>”) symbol. Consider the use of a 

label, either alone or in combination with a symbol. 

9 Difficult to retrieve occurrence data for non-

expert users (p. 53) 

9. Adopt a direct manipulation stile to filter 

occurrence data. 
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5.3.1 # 1: SPI sub menus disappearing from user view when shrinking the ATCSM Project Window 

When shrinking the ATCSM Project Window from the full screen view to a smaller size view, some SPI sub 

menus located on the right side of the SPI menu can disappear without leaving any text or symbol displayed 

that reminds the user of them. This usability concern is illustrated by the figures below. Figure 33 shows a full-

screen view of the ATCSM Project Window, and circles in red the sub menus in question, i.e. “Change Style”, 

“Hide/Show”, “Options”, “Recalculate”, and “Export”. Figure 34 and Figure 35 show a centred-on-screen and a 

half-screen view respectively of the ATCSM Project Window. Here it is possible to see that the names and 

options of the sub menus in question have disappeared from the screen either entirely (Figure 2) or in part 

(Figure 3), without leaving a graphical indication to remind the user of their existence. The remaining empty 

boxes—circled in red in Figure 34 and Figure 35 —perform poorly as a reminder because they solely signify 

that some submenus are hidden on the SPI menu, but do not specify which one. In standard desktop 

applications a symbol and/or a text would normally remain visible to facilitate the recognition of hidden HMI 

items. 

 

This condition violates a basic usability heuristic according to which the system should minimize the user’s 

memory load by making options, objects, and actions visible to her/him. For the user, it is easier to recognize 

information visible on the screen than recalling it in fact. In this specific case, the user wishing to use the 

required menus has either to enlarge again the ATCSM Project View or to recall from her/his memory the 

original submenu position.  

 

Recommendation: 

1. Ensure that a symbol specific for the SPI submenus remains visible when ATCSM Project view is shrunk. 

 

 

 
Figure 33: ATCSM Project View, full screen view. 
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Figure 34: The “Options”, “Recalculate”, and “Export” sub menu disappear after shrinking the ATCSM Project View to a 

centre-on-screen view. 

 

 

 

Figure 35. …also the “Change Style”, and the “Hide/Show” sub menu disappear  

when shrinking the ATCSM Project View to a half-screen view. 



 

     

    

Ref: ASCOS_WP2_JRC_D2.4 Page: 48 

Issue: 1.1 Classification: Restricted 

    

 

ASCOS — Aviation Safety and Certification of new Operations and Systems Grant Agreement No. 314299

 

 

5.3.2 # 2: SPI recalculation options not immediately visible to the user 

When an SPI has been created or modified, the natural expectation for the user is that a new graph is created 

or an existing one is automatically updated. Instead, the user is presented with the following message in red: 

“Definition has changed and the SPI needs to be recalculated." (see Figure 36). From the perspective of a user 

unfamiliar with the system, this message is unexpected and creates the impression that something went 

wrong during the definition of the SPI. In turn, s/he may get stuck because, on the one hand, s/he is under the 

assumption to have committed a serious error during the editing of an SPI, due, for instance, to having 

uploaded the wrong set of exposure data; on the other hand, s/he does not see any suggested information 

about how to recover from the mistakenly assumed error. So, s/he would spend time to check which is the 

appropriate function that allows to create or update the graph as intended. 

 

To note that the expectation that the SPI calculation should occur automatically—with no additional step after 

the “ok” button is pressed in the SPI window—, arises because when editing an SPI, the user's options 

available in the SPI window are restricted to the buttons “ok” to approve the change(s) or “cancel” to reject it; 

however, these do not include the options for SPI recalculation. These only appear as inactive in the 

background view, the ATCSM Project View, outside of the immediate window the user is working on, and far 

from the “ok” and “cancel” buttons (see Figure 37). Consequently it is very unlikely that a user would notice 

the recalculation submenu when working on/closing the SPI window. 

  

Recommendation: 

2   Place the recalculate option in the context of the SPI window. 

 

 
Figure 36. The message in red is displayed to the user after modifying/creating a SPI. 
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Figure 37. The SPI windows does not provide the option to recalculate the graph (circle 1). At the same time, the recalculate 

function (circle 2) falls out of user’s immediate focus of attention as it is located outside of the immediate context the user is 

working on (the SPI window). 

 

5.3.3 # 3: Lack of clarity between the “File” sub menu, the “Project” menu and the entities they relate to 

In the menu bar, the current “File” submenu (Figure 38) may induce the user to think mistakenly that by 

opening, modifying, or closing a file s/he would manipulate a different entity than a library (and the SPIs 

contained in it). This shortcoming creates uncertainty on the user side who may wonder what entity does the 

“File” menu refers to and how it fits in the context of the ATCSM.  As a general rule, the system should show 

clearly which buttons have an effect on which entity in order for the user to create a correct image of the 

system she or he is using. For instance, the SPI menu (see Figure 40) creates a correct image of the system 

because the submenus and options it contains are SPI specific, i.e. they allow the user to manipulate SPIs and 

their graph. The same clarity should apply also to the other menus and submenus. The ATCSM system should 

let the user understand that all of the options available under the “File” submenu have an effect on the library 

that is open at a specific time. This clarity can be achieved by replacing the generic “File” label with the more 

specific “Library”. 

 

The same problem applies to the “Project” menu Figure 39). Also here the user may be induced to think 

mistakenly that there exist an additional entity beside library and SPIs, without however having a clear idea of 

what such a “Project” entity is. The associated submenus—“Filters”, “Exposure Data”, “Category”, and 

“Import/Export”—appear all options affecting a library as a whole in fact. 

2 

1 
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Recommendations:  

3.1 Replace the name of the submenu “File” with “Library”. 

3.2 Consider moving the current four submenus appearing under the “Project” menu under the File (Library) 

menu. 

 

Figure 38. The “File” menu 

 
Figure 39. The “Project” menu 

 

Figure 40. The SPI menu 

 

5.3.4 #4: Opening requires the user to open the ATCSM first 

The ATCSM user interface is organized around libraries. These are containers of SPI(s). When the user opens a 

new file s/he is actually opening a library of SPIs. Without a library open, the tool cannot be used. So, a user 

would expect to be able to launch the ATCSM simply by clicking on a given library available on the desktop (or 

any other file location), analogously to what happens for standard desktop applications (e.g. clicking on a MS 

Word Document file on the desktop allows the user to open the desired file without having to open MS Word 

first). With the current version the user is required to lunch the ATCSM first, and the opening the file of 

interest. 

Recommendation: 

4 Consider giving the option to the user to launch the programme directly by double clicking on the library file 

icon 
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5.3.5 #5: The application name in the Windows “start menu” differs from the application name appearing 

on the top of an ATCSM Project window. 

As shown in Figure 41, the application name appearing on the top of the ATCSM Project Window (“ASCOS 

Continuous Safety Monitor”) differs from the application name displayed on the Windows start menu (“ASCOS 

SPI tool”). As a general rule the user should not have to wonder whether different words, situations or actions 

mean the same thing.  

 

Figure 41. The program name displayed on the top of the main ATCSM view  differs from the name appearing in the 

Windows Start menu. 

 

 

5.3.6 #6: Library name on the top bar of the main software window not clearly distinguishable 

Once the ATCSM is open, the library name appears on the top bar of the main programme window as part 

of the library file path (see figure below). This format makes it clumsy for the user to read the file name and 

understanding whether s/he is working on the intended library. The library name the user is working on 

should be clearly readable, and hence should be presented as a standalone label and not into the file path.  

 

Recommendation:  

6 Replace file path information on the top bar of the ATCSM with the name of the currently open library. 
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Figure 42. Magnified view of the text appearing on the bar on the top of the ATCSM Project window. 

 

5.3.7 #7: Repetitive selection of query text line required in the SPI query builder 

When editing a query in the “SPI Query builder” window, by default the selection blue bar appears on the first row of the 

active window (see  

Figure 43). As the first row usually displays a brace bracket and not a line of text, which is what needs to be 

modified, the user has to select the first row in which the text line appears. S/he does so by moving the 

cursors over the text line of interest and by clicking on it. This micro pattern of activity is repeated every 

time the user opens the SPI query builder in order to add or edit a query. The interaction with the system 

can be eased by placing the selection bar automatically on the first row in which the text line is available 

when the SPI query builder window is opened. 

 

Recommendation 

7.  When opening the SPI Query builder, the selection bar should appear automatically over the first row of 

the active window in which a text line appears.  

 

 

 
 

Figure 43. SPI Query builder 

  

The selection bar (in blue) 

appears by default on the 

first row of the active 

window, rather than on 

the  

first available row with a 

line of text 
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5.3.8 #8: Ambiguous symbology used for the editing function 

The ATCSM uses consistently the icon “>” for the editing function in different menus. However, the icon 

“>”is the standard symbol used worldwide for indicating the “play” function. Hence, it comes unnatural for 

the user to associate this symbol to the editing function if not briefed about it. This can create uncertainty 

for the user when working on the SPI edit window. During the exploration and familiarization phase with 

the tool, s/he user may hesitate to press the “>” button available because s/he may assume mistakenly that 

once pressed this will initiate the execution of a (potentially time consuming) query. 

 

Recommendation 

8. For the editing function, use a symbol different from the play (“>”) symbol. Consider the use of a label, 

either alone or in combination with a symbol. 

 

 
 

Figure 44. The SPI edit window 

5.3.9 #9: Difficult to retrieve occurrence data for non-expert users.  

For a user new to the ECCAIRS software it can be difficult to extract occurrence data. The reason why this may 

be the case is illustrated next.  

Switching the mode of thinking from a ‘user perspective’ to a ‘developer’ perspective. When setting the 

attributes to retrieve a given set of occurrences, the user has to switch thinking mode: in particular s/he has to 

switch from what we could define a (i) user perspective, in which the main goal is thinking about the search 

criteria for identifying a given occurrence data set — e.g. concerned aerodrome(s) or airline(s), type of events, 

etc.—, to a (ii) developer perspective, in which the goal becomes the development of a query needed to 
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retrieve the relevant data from the ECCAIRS database. Besides differing in term of the user goals (see the Table 

below), these two perspectives differ also in terms of the task the user has to perform to meet his objective, 

the focus of attention, and the required knowledge. 

Regarding this latter point in particular it can be noted that switching from a user perspective to a developer 

one brings a major knowledge demands. In fact it requires s/he to have a sufficient knowledge of the ECCAIRS 

taxonomy, of the syntax needed to interrogate the taxonomy, i.e. to build the query, and familiarity with 

command line interaction style. Such knowledge cannot be necessarily assumed for a user familiar with 

general desktop applications but new to ECCAIRS. 

Table 2. A comparison of the user and the developer perspective. 

 A. User Perspective B. Developer Perspective 

(1). Goal Identify and trace  the rate of 

occurrence of one or a group of 

safety events over a selected time 

period 

Interrogate the ECCAIRS database to 

derive occurrence data 

(2). High Level 

Tasks 

 

• Select the relevant SPI 

• Set the relevant filters to 

retrieve a given type occurrence 

data 

• Select the relevant SPI 

• Build the query to retrieve the 

desired occurrence data from the 

ECCAIRS database 

(3). Focus of 

attention  

• SPI graph or group of graph 

displayed on the ‘SPI Pane’ 

• String displayed on the ‘Query 

Window’ 

(4). Required 

Knowledge 

 

-   ASCOS SPI, 

-  Domain(s) of application (e.g. 

ATM, Aviation) 

-   Geographical area and time 

period of the safety events of 

interest  

• Knowledge of ECCAIRS taxonomy 

• Knowledge of the correct syntax to 

build a query, in order to 

interrogate the ECCAIRS database 

 

Further, this knowledge demand has a set of implications regarding how well the tool behaves in terms of 2 

important usability aspects, i.e. learnability and memorability. These aspects refer respectively to (i) how easy 

it is for the user to acquire the knowledge needed to use the tool and (ii) how easy it is to retain such 

knowledge over time. From a learnability perspective, it can be observed that because of the knowledge 

demand described above a user needs to be provided with a sufficient level of training before being able to 

explore and exploit the power of the system in full autonomy, i.e. without expert assistance. On the other 

hand, without such a training, there is a significant risk of refusal to use the tool from the user side, even if he 

or she has gained an initial intuitive understanding of its potential. This is due to two reasons: First, a general 

user, especially when using the system for the first time, could just count on the information visible on the 

screen, and this is not sufficient to guide the user to the build-up of a query. Second, the time needed to 
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familiarize with the system without any expert assistance would exceed significantly the time needed to 

familiarize with a standard desktop application.  

Concerning memorability, it can be noted that SPI definition may not be a frequent task, i.e. something done 

on a daily or weekly basis. In a nominal scenario focusing on continuous safety monitoring, it is reasonable to 

expect that once a user defines one or a set of SPIs, s/he will monitor such SPI(s) over a period of time ranging 

from a few months to a few years without needing to modify the SPI(s) in question. So, the knowledge needed 

to specify or build a query using the syntax may fade away before the next use, with the end result that the 

user may not remember how to do things with the system. 

Finally, it has to be noted that the time needed to develop the query affect the usage also for a user 

acknowledgeable with the ECCAIRS taxonomy and command line interaction style. Although such a user can 

quickly recall from his or her working memory the knowledge needed to operate the system almost 

unconsciously, s/he would still need to spend time performing the tasks needed to type and build the syntax. 

Recommendation 

9. Adopt a direct manipulation style to manipulate/retrieve occurrence data. The usability issue described in 

this section can be avoided by letting the user to retrieve the desired occurrence data by operating a set 

of filters directly on the SPI graph window. This would simplify the interaction because for two 

interrelated reasons: first, the user could interact quickly with the filtering option in the same pane in 

which the object of interest—the SPI graph—appears; second, in doing so he would be saved from the 

effort of having to build the query manually through a sequence of command lines. To date, the system 

implements already this interaction style for letting the user to specify the time period of interest for a 

given SPI in the SPI graph window. A similar mode of interaction could be devised also for allowing the 

user to manipulate directly other attributes of the occurrence data set.  

5.4 Independent usability assessment 

An independent evaluation of the ASCOS Tool for Continuous Safety Monitoring (ATCSM) was made by NLR, 

following the paragraphs of chapters 2 and 3 of the ATCSM User Manual. The description of the tool in the 

User Manual is clear. All the described items, including SPI visualisation have been selected and evaluated.  

5.4.1 Comments: Section 2.2.1 “The SPI project window”, subsection “The SPI header”: 

The info button ( ) shows the criteria used to extract data from the ECCAIRS occurrence data base on the SPI 

graph pane. A distinction is made in a Main-section and a Benchmark-section. In the Benchmark-section both 

the global and the local SPI criteria are shown. In the Main-section the global criteria, as defined for the base 

filter in the projects-window, are not shown, only the local SPI criteria. 
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5.4.2 ATCSM – Control menus 

All described menus have been selected and evaluated. As part of the evaluation new projects have been 

defined and new SPIs have been defined with new criteria built up from scratch. Also criteria have been edited 

and the SPI have been calculated, recalculated and stored. Queries have been exported and imported. 

Exposure data has been selected and applied. SPI results have been exported. 

5.4.3 Comments: Section 2.3.3 “The SPIs menu”, subsection “The SPI edit window”: 

The scaling factor is a little confusing. A scaling factor of 1000 means that the values shown in the graph have 

been multiplied with a factor 1000. So the shown values are per 1000. This is not made clear in the text on the 

Y-axis. This is especially confusing when small scaling factors are used (e.g. factor 2 to influence the range of 

the scale for reasons of comparison). More confusing is that the data pane (made visible with the data thick-

mark) does not show the real rate values but instead the scaled rate values. This is not mentioned in the data 

pane and can easily be missed. 

5.4.4 Comments: Section 2.3.3 “The SPIs menu”, subsection “The SPI exports”: 

When an export is made to Excel not the real values of the occurrence rates are exported but instead the 

scaled rate values. When a scaling factor of 1000 has been applied all rates are a factor 1000 the high in the 

resulting Excel file, as well on the SPI sheet as on the data sheet. This factor is not mentioned in the Excel file. 

5.4.5 Conclusions from the usability assessment 

The ASCOS Tool for Continuous Safety Monitoring (ATCSM) has been evaluated using the User Manual as a 

guide. The items described in the User Manual have been selected and evaluated. In the evaluation some 

items were found that could be improved according to NLR (see also Appendix A).  

5.5 Conclusion of the Usability Evaluation 

The evaluation has diagnosed nine usability issues with the ATCSM tool. These issues identify shortcomings 

and areas of discomfort that can compromise the ease of use of the ATCSM. Each usability issue has been 

provided with a minimum set of high level recommendations that can feed into a subsequent design 

improvement cycle.  In particular, issues from #1 to #8 cover relatively small scope usability issues, which call 

for incremental changes at the level of the Human-Machine Interface of the present version of the ATCSM. 

Issue #9 addresses a more fundamental (and complex) usability concern instead. This arises from the 

knowledge demand the system has on a general user, and calls for software changes aimed at automating the 

build-up of the ECCAIR database interrogation query.  

It has to be noted that the identified issues are reasonable considering the novelty of the application and its 

maturity level.  At the same time addressing them is important to make the potential of the system more 

transparent to the broad communities of safety and certification experts that may have an interest on the use 

of the tool in a certification context and beyond. 
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 Conclusions and recommendations 6

6.1 Conclusions 

Based on ASCOS requirements, a tool has been developed to facilitate the continuous monitoring of aviation 

safety. The functioning of the tool has been tested based on randomly generated occurrence test data and 

simulated usage data. A User Manual has been developed to guide use of the tool by interested parties. 

The usability of the tool has been evaluated and assessed by two independent organisations. 

Recommendations for improvements have been made. All, except one, have been implemented. The user 

manual has been updated accordingly. The specifics of the improvements made are listed in Appendix A. 

The tool provides a picture of aviation safety. This quality of this picture will reflect the completeness and 

quality of the data. Experience has shown that much effort will be required to obtain the quality data needed 

to make this picture meaningful.  

6.2 Recommendations 

Simplifying access to exposure data 

The present way to upload exposure data is to read an XML file which complies with a pre-defined structure. 

However, there is presently no tool at hand that reformats exposure data from the various source data 

formats to the format in which the data is usable by the tool.  

This aspect has been intentionally left open in light of the many formats in which exposure data may be found. 

In a “production environment”, it would be required to develop additional software to interface between the 

tool and, e.g., a data warehouse containing the exposure data. 

In the selection of the exposure data for the purposes of developing SPI’s, the following aspects need to be 

covered: 

- The definition of the part of the aviation industry to be covered - usually expressed through a 

selection of aircraft involved, the types of operations involved, the aerodromes involved etc. 

- The time frame for the observation. 

 

This information is also included in the queries retrieving occurrences.  They also would include a time frame, 

the part of the industry to be covered in addition to the nature of the events to be selected. Consideration 

should be given to develop queries to extract matching exposure data from a data warehouse based on the 

information contained in the queries to extract the occurrence data from an occurrence report repository 

Consequently, compatible taxonomies must be used for the storage of exposure data and occurrence reports. 

This is not possible today. It is no surprise. Occurrence data and exposure data have traditionally been 

collected by different groups and for different purposes. 
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Improving the control of Safety Performance Indicator (SPI) images 

Several global parameters control the image of the SPIs in an SPI library. As a result, all SPIs in a library share 

the same style settings. While this approach permits the rapid change of the style of all SPIs in a library, it 

limits the flexibility and requires the user to use multiple libraries when images of different styles are required.  

Consideration could be given by developing an approach in which the image of an SPI graph is determined by a 

“style:” that the user can associate to an SPI.  “Styles” would be managed separately and could be stored in a 

“style library”. The definition of an individual SPI would then be based on: 

- The occurrence data query; 

- The assignment of exposure data; 

- The image control style; 

- SPI name, explanation and associated graph titles. 

 

Identification of ASCOS related products in occurrence and usage data 

At the time of writing this document (2014), there is no product at hand that has been certified using ASCOS 

related approaches. If and when products/systems will be certified following the ASCOS approach, it will be 

necessary to identify such products/systems as ASCOS related so that their safety can be monitored separately 

from the overall safety of the aviation system.  

No such means of identification exists today. This applies to occurrence as well as to usage data. 
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Appendix A  

JRC response to recommendations 

The JRC reaction to the recommendations made by Deep Blue and the NLR is summarized below. Where 

possible, recommendations were implemented.  For some, the implementation attempted to address the 

issue concerned but did not follow the precise recommendation. Instead an alternative solution was provided 

aimed at implementing the intent of the recommendation. 

Table 2.Rrecommendations and JRC reactions 

# Identified Usability Issues  

(page number is indicated in brackets) 

Recommendation(s) JRC reaction 

1 SPI sub menus disappearing from user 

view when shrinking the ATCSM Project 

Window (p. 46) 

1. Ensure that a symbol 

specific for the SPI submenus 

remains visible when ATCSM 

Project view is shrunk 

Implemented, icons 

added 

2 SPI recalculation options not immediately 

visible to the user (p. 48) 

2. Place the recalculate option 

in the context of the SPI 

window. 

Implemented by a 

triggering recalculation 

when closing the SPI 

edit window 

3 Lack of clarity between the “File” 

submenu, the “Project Menu” and the 

entities they relate to (p. 49) 

3.1 Replace the name of the 

“File” submenu with 

“Library”. 

3.2 Consider moving the 

current four submenus 

contained under the “Project” 

menu under the File (Library) 

menu. 

Implemented, menus 

revised 

4 Opening a library requires the user to 

open the ATCSM first (p. 50) 

4. Consider giving the option 

to the user to launch the 

ATCSM directly by double 

clicking on the library file icon 

available on the desktop. 

Implemented 

5 The name of the application displayed in 

the Windows “start” menu differs from 

the application name appearing on the 

top of the ATCMS Project window (p. 51) 

5. Use the same software 

name consistently across 

different menus and bars. 

Implemented, names 

aligned 

6 Library name appearing on the top bar of 

the main software window not clearly 

readable 

(p. 51) 

6. Replace file path 

information on the top bar of 

the ATCSM with the name of 

the currently open library. 

Implemented by 

providing file as well as 

library name 

7 Repetitive selection of the query text line 

required in the SPI query builder (p. 52) 

7. When opening the SPI 

Query builder, the selection 

bar should appear 

automatically over the first 

row of the active window in 

which a text line appears. 

 

Superseded:  the query 

text line can already be 

edited directly by 

double clicking on the 

line.   
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8 Ambiguous symbology used for the 

editing function (p. 53) 

8. For the editing function, 

use a symbol different from 

the play (“>”) symbol. 

Consider the use of a label, 

either alone or in combination 

with a symbol. 

Implemented, different 

icon used 

9 Difficult to retrieve occurrence data for 

non-expert users (p. 53) 

9. Adopt a direct 

manipulation style to filter 

occurrence data. 

Not implemented  

10 Enhance information provided when 

pressing the “info” button  

The criteria of the queries are 

shown, however, the 

information on the “main” 

filter is missing 

Implemented, 

information on the 

main” filter added 

11 The term “scaling” on the y-axis of the 

graph is confusing 

The user may not understand 

what is meant by scaling 

Implemented, changed 

the text from “scaling” 

to “per” as the rates are 

“per” the scaling factor, 

e.g. per 100 000 flight, 

hours etc. 

12 The data window does not include 

information on the scaling factors used 

Without the scaling factor 

being shown, the user is not 

aware which factor has been 

applied. 

Column containing the 

scaling factor has been 

added to the data 

window and to the 

exports 

 

One recommendation was not implemented. It concerned “Adopt a direct manipulation style to filter 

occurrence data.”  

The examples shown in the report and the user manual have been drawn up using only some twenty attributes 

of the ECCAIRS system. The user may wish to note that the ECCAIRS taxonomy, however, is made up from 

more than 60 nested entities which contain some 900 attributes, for which, in turn, more than 60 000 coded 

values are possible. In addition, the system contains numerous attributes for free text, numbers and dates.  In 

summary, the visual display and manipulation of a structure of this size and complexity is a challenge, one 

which could not be tackled within time and resources available for this project.   

 


